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Disclaimer 

This document contains material, which is the copyright of certain HEAP contractors, and may not be 
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lication of this document. The commercial use of any information contained in this document may 
require a license from the proprietor of that information.  
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1. Introduction 
The open-source flow for the visualization of the execution parallelism provides: 

• an IDE for the development of C language-based software projects 

• a graphical visualization program that displays and allows the exploration of data dependen-
cies, with automated cross-references to the source code in the IDE. 

The companion tools for data dependency profiling are reported in D3.2: 

• a program to analyse the developer C source code and to generate a functional model in-
strumented with code for data collection during program execution 

• a library to analyse the data gathered during program execution, at run-time, and to generate 
a compact representation of the data dependencies between program instructions. 

A free software virtual machine was configured with the whole chain as a means to achieve a consis-
tent distribution able to demonstrate the tool functionality and receive valuable feedback for its fur-
ther development. 

2. Tool Chain 
The tool chain and the virtual machine make use only of free software tools. 

The changes to the tools as well as the virtual machine configuration provided are considered a beta 
release. Please provide feedback to improve it. 

2.1. Source Code Analysis and Instrumentation 
The source code analysis and instrumentation tool is based on the CIL platform1 (C Intermediate 
Language). CIL is written in ocaml2

CIL is both lower-level than abstract-syntax trees, by clarifying ambiguous constructs and removing 
redundant ones, and also higher-level than typical intermediate languages designed for compilation, 
by maintaining types and a close relationship with the source program. The main advantage of CIL is 
that it compiles all valid C programs into a few core constructs with a very clean semantics. Also CIL 
has a syntax-directed type system that makes it easy to analyse and manipulate C programs. Further-
more, the CIL front-end is able to process not only ANSI-C programs but also those using Microsoft 
C or GNU C extensions. 

 and provides a high-level representation along with a set of 
tools that facilitate the analysis and the source-to-source transformations of C programs. 

A new code analysis and instrumentation module was written for the HEAP project. Some suitable 
existing CIL modules were merged and extended to implement the required functionality for code 
analysis and annotation. 

2.2. Run-Time Data Dependency Tracer Library 
The tracer library was written first in Perl3

                                                      
1 http://sourceforge.net/projects/cil/ 

 to allow fast prototyping of data structures and algorithms 
for analysis. Once the structure was consolidated, it was fully rewritten in C to reduce the run time 

2 http://caml.inria.fr/ocaml/ 
3 http://www.perl.org/ 
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(about 16x speed increase with respect to the Perl version and about 450x slower than the normal 
application run). 

The tracer library is linked with the instrumented application program under analysis to obtain an 
executable program.  To perform the execution analysis, this program should be run using the same 
inputs as the normal (not annotated) application program.  Data dependency is collected during pro-
gram execution and at the end a summary file is generated that contains all the data needed to repre-
sent graphically the dependencies and the cross-references with the source program in the IDE. 

2.3. Data Dependency Visualization 
This tool chain component is based on the free software program ZGRViewer.4  It is a graph visual-
izer implemented in Java and based upon the Zoomable Visual Transformation Machine.5

ZGRViewer is specifically aimed at displaying graphs expressed using the DOT language from 
AT&T GraphViz and processed by programs dot, neato or others such as twopi. It is designed to 
handle large graphs and offers a zoomable user interface (ZUI), which enables smooth zooming and 
easy navigation in the visualized structure. 

 

In the latest version it can provide: 

• overview + detail views; 

• focus+context magnification with Sigma Lenses views; 

• graphical fish-eye focus+context distortion views; 

• navigation along graph edges with Link Sliding; 

• navigation from node to node with Bring & Go. 

The tool chain includes the latest stable release (version 0.8.2), thus the features may differ from the 
latest development version. 

Several classes were developed to integrate ZGRViewer with the HEAP tool chain. Its code and op-
eration were analysed thoroughly to find the best way to integrate it to the HEAP flow to both sim-
plify the integration, the debug, and maintenance of the integration as well as of the whole tool chain. 

Special attention was given to the following objectives: 

• limit as much as possible the changes to the original ZGRViewer code, both as entity as well 
as number. All changes to the original code were well tagged and documented to simplify fu-
ture updates of the ZGRViewer code from the project (porting to newer versions of 
ZGRViewer) 

• define a flexible format for the transfer of the data output by the tracer at the end of the anno-
tated program execution.  An XML template was defined such way to allow for easy data 
structure creation in the viewer and also be flexible enough to easily accommodate future ex-
tensions or other modifications 

• define a bidirectional Inter-Process Communication subsystem to allow the communication 
of commands and data between the viewer and the IDE. The IPC is based on UNIX pipes and 
ASCII commands and data. It allows an easy integration with almost any IDE that is able to 
implement the other end of the IPC, reducing to a bare minimum the compatibility require-
ments between the viewer and the IDE 

                                                      
4 http://zvtm.sourceforge.net/zgrviewer/news.html 
5 http://zvtm.sourceforge.net/ 
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• a powerful graph driver for the GraphViz “dot” layout engine that generates an easy to un-
derstand dependency graph colourisation and a suitable node and arch layout in most cases 

• an efficient cross-reference mechanism between the source code in the IDE and the nodes of 
the data dependency graph, including pop-up windows with data and keyboard short cuts to 
facilitate and speed up the graph exploration; 

• an efficient internal data representation of the graph able to both deal with a large number of 
nodes and edges and also to simplify the graph transformation algorithms. 

The HEAP-specific code was grouped under the “IDE” package with sub-packages for generic IPC 
classes, Code::Blocks-specific IPC classes, graph and IR classes, and utility classes. Both the 
ZGRViewer project and the HEAP additions make up a single project under the NetBeans IDE (see 
annex 5). 

Most of the functions and graphic interface are presented in detail in the following sections. 

2.4. IDE 
The IDE functionality is provided by Code::Blocks.6 Code::Blocks is a well established cross-
platform IDE that supports projects in C/C++/D languages. It runs on Linux, OS X, and Windows 
platforms providing by design a consistent look, feel, and operation mode. It is written in C++ using 
the wxWidgets7

The IDE functionality was extended to suit the specific requests of the HEAP project, in particular 
the interface with the graph viewer based on the Java project ZGRViewer. 

 library and is designed to be very extensible and fully configurable. 

The recommended way to extend the functionality of the IDE is by writing plug-ins. The plug-ins can 
be written either in an IDE-specific scripting language or in C++, like its core. To decide what lan-
guage to use it was considered that writing a script requires less time than writing C++ code, but the 
scripting interface did not allow to spawn threads, feature needed to handle the IPC with the view via 
UNIX pipes. Consequently, the plug-in had to be written in C++. 

The plug-in implements all the functionality needed to integrate the ZGRViewer-based graph viewer 
into customized for HEAP in the Code::Blocks IDE to offer the designer a single interface for con-
trolling the development and optimisation of the project. To this end, the plug-in extends the IDE 
functionality with: 

• ability to create the communication pipes and to spawn the viewer process upon the devel-
oper command using a specific HEAP menu 

• automatically connect to the viewer process using the pipes to establish the first contact with 
the viewer after its initialization 

• implement the IPC listener and transmitter, and the IPC protocol for exchanging commands 
and data with the viewer 

• implementing the interaction with the IDE elements (e.g., the editors, the menus, the project 
information) necessary to provide the developer the needed visual feedbacks, such as: 

 open and select the line requested by the developer through the viewer interface (for in-
stance to display the line represented by a graph node) 

 retrieve and send to the viewer the number required of context lines for a given source 
code line that are used to display on the graph the source code context for a given node 

                                                      
6 http://www.codeblocks.org/ 
7 http://www.wxwidgets.org/ 
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 provide the block folding information for all project files to the viewer to collapse the 
corresponding nodes 

 send the viewer the refresh command upon developer click on the “update” item in the 
HEAP menu 

• ability to end the viewer process and remove the communication pipes upon developer com-
mand using the HEAP menu 

• interact with the IDE graphical elements, such as main and context menus. 

Most of these functionalities and graphical items of the HEAP plug-in are presented in detail in the 
following sections. 

3. Demo Virtual Machine 
A Linux8 VirtualBox9

The users defined on the virtual machine are: 

 virtual machine (VM) was configured to reliably support the functionality of 
the tool chain.  Its installation is described in D3.2, where the reader is now referred. 

• root with the password: Demo11HEAP 

This login can be used to perform administration tasks on the VM, if required. 

• heapdemouser with the password: Demo11HEAP 

This login is used for all tool chain-related activities. 

Demo Project 

The buttons to launch the applications of interest are exposed for convenience on the top panel of the 
workspace, right next to Fedora menus: 

 

 

From left to right, they are: 

•  opens a terminal window; 

•  opens Code::Blocks IDE; 

•  discards a hanged instance of the Code::Blocks IDE; 

•  displays the user manual of the distribution. 

3.1. Load the Demo Project 

Click on the Code::Blocks button ( ) to start the IDE: 

                                                      
8 https://secure.wikimedia.org/wikipedia/en/wiki/Linux 
9 http://www.virtualbox.org/ 
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Select “File” from the top menu, then click on “Open...”.  In the file chooser window that opens 
navigate to “heapdemouser/projects/mjpeg_par”, select “mjpeg_par.cbp” and click on “Open”: 
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The “mjpeg_par” project will open: 

 



FP7-ICT-247615 - HEAP 
Free Software-Based Flow for the Visualization of the 
Parallelism in the Program Execution -- User Manual and Tutorial 

HEAP_D3.4_V1.4_20120123  Page 13 of 25 

Now start the visualization program by clicking on the “HEAP” entry of the top menu and then on 
“Run”: 

 

The ZGRViewer visualizer window will open: 

 

Arrange the IDE and the ZGRV windows on the screen to have a clear view of both. If you have two 
monitors attached to the host machine you may wish to move the ZGRV window on the second 
monitor of the VM and then move this VM second monitor window on the second physical monitor 
of the host. 

3.2. Run the Demo Analysis 
The analysis tool chain is run from the command line. A script is provided that loosely glues together 
the whole chain. 

Note: the instrumented program runs about 450 times slower than the native run. 

Open a terminal window by clicking on the icon in the top panel of the workspace and go into the 
directory of the mjpeg_par project of the IDE: 
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In this directory run the tracer.sh script with arguments: 
 tracer.sh -- mjpeg_par.c 

where: 

• -- (double dash) ends the command line options that are passed to the compiler and linker; 

• mjpeg_par.c is the name of the source file to analyse: 
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where: 

• + /home/heapdemouser/projects/tracer/cil-1.4.0/bin/cilly is the starting command for CIL 
compilation 

• the three gcc compilations that follow are part of the cilly run and generate the instrumented 
model of the user program, mjpeg_par.cil.c 

• + rm -f mjpeg_par.i mjpeg_par.o mjpeg_par.cil.i cleans the temporary files from the di-
rectory 

• the next gcc run compiles the CIL model (mjpeg_par.cil.c) and links it with the data depend-
ency tracer library (libheap) and other system libraries (libxml2, libavl) 

• the rm command cleans the temporary files from the directory 

• the data dependency tracer is then run. It actually runs the user program instrumented for 
data dependency tracing together with the data dependency tracer 

• finally, the mv command renames the file with the generated data to the name expected by 
the ZGRViewer-based visualizer. 

3.3. Run the Data Dependency Visualization 
After each operation that can affect the visualization (e.g., change the folding in the IDE editor, up-
date the visualizer data) the visualizer should be informed on the update. Access the HEAP menu on 
the top menu of the IDE and click on the “Update” entry: 
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Notice how the visualizer window displays the data dependency among program instructions: 

 

Each ellipse represents a program instruction that was executed. The ellipse colour can vary from 
white (seldom executed) to intense red (most executed). 

Each directed arch that connects two ellipses represents a data dependency between the two instruc-
tions. The arch colour can vary from light cyan (for seldom occurring dependencies) to intense red 
(for most occurring dependencies) and, at the same time, the arch width is modulated by the same 
factor, the widest for the most occurring. 

The visualizer implements a few handy short cuts: 

• ‘c’ -- with the cursor on a node, display the source code of the node with 5 context lines: 
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• ‘C’ -- with the cursor on a node, display the source code of the node with 10 context lines: 

• ‘e’ -- with the cursor on a node, move the IDE editor cursor on the source line corresponding 
to the node; 

• ‘m’ -- with the cursor on an arch, display the unabridged list of data dependencies repre-
sented by the arch: 
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• ‘g’ -- best fit of the graph on screen; 

• use the mouse wheel to zoom in/out. 

To further facilitate the exploration of the data dependencies, the graph nodes can be folded by fold-
ing in the IDE the lines corresponding to the nodes source lines. For instance, by folding all blocks in 
the IDE we obtain the dependency view between the functions: 

• fold all the blocks in the IDE: 

• update the visualizer: 
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The nodes still visible are the function arguments. 

4. New Project 
Creating a new project for data dependency analysis requires the following steps: 

1. create a new project under the IDE and populate it with the project source files (please refer 
to the Code::Blocks documentation10

Unless you are going to use Code::Blocks for development, importing a project for data de-
pendency analysis is usually just a matter of copying the project file tree under the project di-
rectory using standard GUI or command line tools 

 for detailed explanation and to annex 6). 

2. make sure the project compiles well with the native compiler (gcc), runs and produces the 
proper results 

3. apply the data dependency analysis as described in section 3.2; 

4. visualize the data dependency results as described in section 3.3. 

An important aspect to consider when creating a new IDE project is its location. If the project direc-
tory is set on the VM virtual disk it can be lost with the next updates of the VM. It is safer to create 
the project on the host file system that is accessible to the host OS using the shared folders configura-
tion in section 3. 

 

                                                      
10  http://wiki.codeblocks.org/index.php?title=Creating_a_new_project 
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Annexes 

5. NetBeans Project for HEAP extensions and 
ZGRViewer 

The HEAP-specific classes are expanded in the left panel. 

The ZGRViewer project is unexpanded, under the net.claribole.zgrviewer and 
net.claribole.zgrviewer.dot packages. 

The external ZGRViewer libraries and utilities are located under the “Other Sources” and “Libraries” 
folders. 
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6. Excerpts of Code::Blocks Documentation on Crea-
tion of a New Project 

This section is a guide to many of the beginning (and some intermediate) features of the creation and 
modification of a Code::Blocks project. If this is your first experience with Code::Blocks, here is a 
good starting point.  

6.1. The project wizard 
Launch the Project Wizard through File->New->Project... to start a new project. Here there are 
many pre-configured templates for various types of projects, including the option to create custom 
templates. Select Console application, as this is the most common for general purposes, and click Go.  

 
The console application wizard will appear next. Continue through the menus, selecting C++ when 
prompted for a language. In the next screen, give the project a name and type or select a destination 
folder. As seen below, Code::Blocks will generate the remaining entries from these two.  
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Finally, the wizard will ask if this project should use the default compiler (normally GCC) and the 
two default builds: Debug and Release. All of these settings are fine. Press finish and the project will 
be generated. The main window will turn gray, but that is not a problem, the source file needs only to 
be opened. In the Projects tab of the Management pane on the left expand the folders and double 
click on the source file main.cpp to open it in the editor.  

 
This file contains some default code. 

6.2. Changing file composition 
A single source file is of little uses in programs of any useful complexity. In order to handle this, 
Code::Blocks has several very simple methods of adding additional files to the project. 

6.2.1. Adding a blank file 
To add the new file to the project, bring up the file template wizard through either File->New-
>File... or Main Toolbar->New file (button)->File... 
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Select C/C++ source and click Go. Continue through the following dialogues very much like the 
original project creation, selecting C++ when prompted for a language. On the final page, you will be 
presented with several options. The first box will determine the new file name and location (as noted, 
the full path is required). You may optionally use the corresponding button to bring up a file browser 
window to save the file's location. Checking Add file to active project will store the file name in the 
Sources folder of the Projects tab of the Management panel. Checking any of the build targets will 
alert Code::Blocks that the file should be compiled and linked into the selected target(s). This can be 
useful if, for example, the file contains debug specific code, as it will allow the inclusion (or exclu-
sion) from the appropriate build target. In this example, however, the hello function is of key impor-
tance, and is required in each target, so select all the boxes and click Finish to generate the file. 
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6.2.2. Adding a pre-existing file 
Click Project->Add files... to open a file browser. Here you may select one or multiple files 
(using combinations of Ctrl and Shift). (The option Project->Add files recursively... will 
search through all the subdirectories in the given folder, selecting the relevant files for inclusion.) 

Click Open to bring up a dialogue requesting to which build targets the file(s) should belong. For this 
example, select both targets. 

 
Note: if the current project has only one build target, this dialogue will be skipped. 

6.2.3. Removing a file 
Using the above steps, add a new C++ source file, useless.cpp, to the project. Removing this un-
needed file from the project is straightforward. Simply right-click on useless.cpp in the Projects tab 
of the Management pane and select Remove file from project. 
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